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Notice

The information in this document is subject to change without prior notice in order to improve 
reliability, design, or function and does not represent a commitment on the part of this company.

In no event will we be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use or the inability to use the product or documentation, even if advised of the 
possibility of such damages.

Copyright © 1997 - 2010 SoftLab-NSK Ltd.
All Rights Reserved.

No part of this reference manual may be reproduced or transmitted in any form or by any means 
without the prior written permission of this company.

Throughout this manual, we make reference to product names that are trademarks of other 
companies. We are using these names for identification purposes only, with no intention of 
infringement of the trademarks.

FCC Information

FCC ID:	

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications.  However, there is no guarantee that 
interference will not occur in a particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
Consult the dealer or an experienced radio/TV technician for help.

Shielded cables and I/O cards must be used for this equipment to comply with the relevant FCC 
regulations. Changes or modifications not expressly approved in writing by SoftLab-NSK Ltd. may 
void the user’s authority to operate this equipment.

Limited Warranty

Our company warrants this product against defects in materials and workmanship for a period of 
one year from the date of purchase.  During the warranty period, products determined by us to be 
defective in form or function will be repaired or replaced at our option, at no charge.  This warranty 
does not apply if the product has been damaged by accident, abuse, misuse, or as a result of service 
or modification other than by us.

This warranty is in lieu of any other warranty expressed or implied.  In no event shall we be held 
liable for incidental or consequential damages, such as lost revenue or lost business opportunities 
arising from the purchase of this product.
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Introduction

The SLNewsLine program is designed for creating tasks for 
scrollable crawl line in automatic mode. The task is based on 
data received from different sources. 

The sources can be the following:
RSS news; ●●
weather stations; ●●
text files;●●
system clock; ●●
graphic files.●●

One task may contain data from different sources. There is also 
a possibility to create several tasks for different scrollable crawl 
lines simultaneously. 
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General Workflow

This section contains information on how the SLNewsLine 
program can be used if it is necessary to display scrollable crawl 
line by giving an example. Let it is necessary to display the 
following information in crawl line in the given order: current 
date, current time, picture, the text of the latest news.

Complete the following steps to prepare the task for scrollable 
crawl line via the SLNewsLine program:

1.	 Launch the program and create a project.

2.	 Create necessary text generators.

3.	 Create the task based on created text generators.

4.	 Start the task and check its performance in the 
FDTitleDesigner program.

Complete the following steps for specified information to be 
displayed in the scrollable crawl line: 

1.	 Load title project with the RollCrawl title element in the 
FDOnAir program. 

2.	 Start prepared task in the SLNewsLine program.

3.	 Launch playback of scrollable crawl line at specified time in 
the FDOnAir program either manually via control buttons 
or according to the schedule.

	 Tip:gg It is recommended to study the example included in the 
SLNewsLine program package. The example is located in the ~\
Plugins\SLNewsLine\Sample folder, where ~ denotes a full path to 
the folder where the ForwardT Software is installed. 
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Launch of the Program and Creation of the Project (Step 1)

1.	 Launch the SLNewsLine program (1) via the Start menu 
command: Programs > ForwardT Software > Plugins > News Line. 

2.	 Select Project > New... from main program menu (2).

3.	 Specify a folder and project name in the Create new project 
window, e.g. Project_morning. Then click Save. 

4.	 Save all changes made in the project via the Project > Save 
command (3). 

5.	 A full path to the project will be displayed in the main window 
title bar (4). 
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Creation of Text Generators (Step 2)

Creation and configuration of text generators are implemented 
in the Text Generators window (1). Use the toolbar buttons (2) or 
the Generators menu (3) to create generators. 

1. Date
Complete the following steps to create a new generator of actual 
date:

1.	 Click the Date button (1).

1
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Configure the following parameters in the Date: creating a new 
one window:

2. Specify generator name in the Name text field (2). 

3.	 Configure the format of date representation by selecting the 
type of displayed information, the format and its order in 
the crawl line. Configuration is made in the Format field (3). 
Add necessary tags in the field in the desired order. It is also 
possible to use free symbols, e.g. point or space besides tags.  
To add the tag:
1. Select the type of information from the Template List drop-
down list (4).
2. Click Add (5).
The following default format of the date is in our example:  
<#dd>. <#mm>. <#yyyy>, 

<#dd>●●  denotes the day;
<#mm>●●  denotes the month;
<#yyyy>●●  denotes the year. 

4.	 Actual date in the specified format is displayed in the  
Preview field (6):

5.	 Select font style in the Text Style field (7) for date designing 
in the scrollable crawl line. 

	 Note: Font styles are stored in EFC file. EFC file is created in the Forward 
Titling program (for more information on font styles collection, see 
the «ForwardTitling: Graphic Editor. User’s Guide»). Select the file 
with font styles collection in the FDTitleDesigner program when 
configuring of the settings of scrollable crawl line title element is 
implemented (for more information on this item, see the «FDTitle 
Designer: Title Project Editor. User’s Guide»). 

6.	 Click OK (8) to apply the settings and to close the window.

2

5
7

8

3
4

6



9

7.	 New generator is added to the table (9). 

2. Time
Complete the following steps to create a new generator of text 
string with actual time: 

1.	 Click the Time button (1).

Configure the following parameters in the Time: Creating a new 
one window.

2.	 Specify generator name in the Name text field (2). 

9
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3.	 Select time source from the Time Source drop-down list (3), 
e.g. System time. In this case the source will be system clock.

4.	 Set parameters of time displaying, e.g.:
1. Put the Leading Zero mark (4) to display zero at the 
beginning of numbers that contain 1 digit, e.g. 04:30.
2. Put the 24 Hours mark (5) to display the time in the 24 
hour format.
3. Select a separator of hour and minute values from the 
Separator drop-down list (6), e.g. colon.

5.	 Time in the specified format is displayed in the Preview field 
(7).

6.	 Select font style according to the index in the Text Style field 
(8). Selected style will be used for designing time displayed 
in the scrollable crawl line. 

7.	 Click OK (9) to apply all settings and to close the window.

8.	 New generator is added to the list (10).

10
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3. Picture Link

	 Note: SPT file with the task for scrollable crawl line contains a link to 
a graphic file, not the picture itself. 
Complete the following steps to create generator of a new 
picture link: 

1.	 Click the Picture Link button (1).

Configure the following paramerters in the Picture: creating a new 
one window:

2.	 Specify generator name in the Name text field (2). 

3.	 Specify a full path to graphic file in the Source File field (3) 
where desired picture is located. Click Browse... (4) to open 
the window for selecting the file.

1

2

43



12

4.	 Select desired file (5) in the appeared window and click Open (6).

5.	 Click OK (7) to apply the settings and to close the window.

6.	 New generator (8) is added to the table. 
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4. Text
Complete the following steps to create new text generator of 
information from text file: 

1.	 Click the Text button (1).

Configure the following parameters in the Text: creating a new one 
window: 

2.	 Specify generator name in the Name field (2). 

3.	 Specify the text to be shown in the scrollable crawl line. 
Click Browse... (3) to select this text file.

4.	 Select desired file (4) and click Open (5).
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5.	 Specify the interval in the hh:mm:ss format in the Update Pe-
riod text field (6). Information from text file will be updated 
in specified interval of time. 

6.	 Select font style in the Text Style field (7). Specified font will 
be used for designing the text in the scrollable crawl line. 

7.	 Click OK (8) to apply the settings and to close the window. 

8.	 New generator is added to the table (9). 

5. RSS News
Complete the following steps to create new generator of RSS 
data: 

1.	 Click the RSS button (1).
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Configure the following parameters in the RSS: creating a new one 
window (1).

2.	 Specify generator name in the Name field (2).

3.	 Specify URL in the Data Source field (3). 

4.	 Specify reviewed period. The news only from this time 
period will be taken. To assign this period:
1. Put the Information no older than the last mark (4). 
2. Specify desired time in the following format: 
Days:Hours:Minutes, e.g. 1 day (5).

5.	 Specify filter for selection of news referred to specified 
categories. Specify these categories in the Categories field (6). 

	 Tip:gg Elements that are specified have the category name.

6.	 Configure the format of displaying the news in the Format 
field (7) by specifying the type of information selected from 
RSS feed and its order in the crawl line. Add tags with 
names of RSS elements from which necessary information 
should be selected. This information will be displayed in 
scrollable crawl line. 
1. Select type of the element from the Template List drop-down 
list (8). 
2. Click Add (9).
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7.	 Select font style in the Text Style field (10). Specified font will 
be used for designing information displayed in scrollable 
crawl line. 

8.	 Specify update period, i.e. time of request to the site, in the 
following format:  
hh:mm:ss (11).

9.	 Click OK (12) to apply the settings and to close the window.

10. New generator is added to the list (13).

13
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Creation of the Task for Scrollable Crawl Line (Step 3)

Creation and configuration of task for scrollable crawl line are 
implemented in the Tasks window (1) via toolbar buttons (2) or 
commands of the Tasks menu (3).

The task in the SLNewsLine program window is presented in 
the format of line. The line may contain free symbols and tags 
with the numbers of used text generators.

Let it is necessary to create the task for scrollable crawl line as 
it is shown below: 

1.	 Click New (1).

Date Time Picture RSS News

1

3 1
2
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Configure the following parameters in the Task: creating a new one 
window:

2.	 Give the name for the task in the Name text field (2).

3.	 Create the task string in the Text Format field. It may contain 
free text and tags with serial number of text generator: 
1. Type the text that will be displayed before the date and 
RSS news in scrollable crawl line, e.g. «Today» and «Hot 
News» respectively (3). 
2. To add tags that contain indices of used text generators: 
Set the cursor in required area to add the tag. Select 
necessary generator from the Text Generators drop-down list (4) 
according to its name. Then click Add (5).

4.	 Specify update period in the task file according to the  
hh: mm: ss format (6). 

5.	 Click Browse... (7) to specify the name of the SPT file for 
scrollable crawl line.
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6.	 Select the folder in the Choose file to save window and name 
the file (8). Then click Save (9). 

7.	 Click ОK (10) to apply the settings and to close the window.

8.	 New task is added to the Tasks window (11). 

	88 Important: SPT file with the task appears in the selected folder only after 
the first start of the task performance. 

8 9
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Control Over Task Performance (Step 4)

Start the task to record actual information in the SPT file for 
scrollable crawl line. 

1.	 Select desired task in the Tasks window and click Start (1) to 
start the task. 

2.	 All text generators of the selected task will be started 
automatically. The state of text generators will be displayed 
by indication (2).

3.	 The content of the task is displayed in view area (3). 

4.	 Click Stop (4) to stop the task. 

5.	 The picture below presents SPT file with the task for crawl 
line opened in Notepad. 

1
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Task performance can be checked via the FDTitleDesigner program. 

1.	 Launch the FDTitleDesigner application (1) via either the 
Start menu command: Programs > ForwardT Software > Titles > Title 
Designer or program shortcut. 

Add the RollCrawl title element to the project. To do so:

2.	 Click the RollCrawl button (2) located on the Element Types 
panel. 

3.	 Drag the pointer to the project workarea where title element 
will be located. Press the mouse button, then move it 
diagonally with releasing (3).

1
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Configure title element parameters:

4.	 Double-click title element located in the project workarea to 
open the window for selecting file with the task. 

5.	 Select the task file created via the SLNewsLine program in 
the appeared window, Result.spt (4) in our example. 

6.	 Specify a full path to the file with font styles collection, i.e. 
EFC file in the Text Formatting field (5).

4

5
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7.	 Start the task for scrollable crawl line by clicking Start (6) in 
the SLNewsLine program window.

8.	 Toggle the Start Preview mode (7) in the FDTitleDesigner 
program.

9.	 Information selected according to assigned task and 
configured settings will be displayed in scrollable crawl line. 
The information will be updated in periods specified in the 
settings of the task in the SLNewsLine program.

	88 Important: Start corresponding task in the SLNewsLine program to display 
actual information. 

  
6
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Useful Links

© Soft-LabNSK

ForwardT Software set: description, download, documentation, solutions
http://www.softlab-nsk.com/forward/index.html

Support 
e-mail: forward@sl.iae.nsk.su

	  forward@softlab-nsk.com

	 forward@softlab.tv

Forum 
http://www.softlab-nsk.com/forum (currently available in Russian only)

Translation from
22 September, 2010

http://www.softlab-nsk.com/forum
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